
 

 

Topaz Labs, LLC 

A Video and Image Enhancement Company 

 

 

TOPAZ Detail 2 ™  

ユーザーズマニュアル 

 

 

 

2010 年 

 

 

http://www.nixus.jp 

 

 

Copyright © 2009 Topaz Labs, LLC.  All rights reserved. 

http://www.topazlabs.com 

http://www.nixus.jp/
http://www.topazlabs.com/


  

 
2 

目次 

 

インストール ................................................................................................................... 4 

インストール方法 ..................................................................................................................................... 4 

シリアル番号入力 ..................................................................................................................................... 4 

ホスト別インストール .............................................................................................................................. 4 

Paintshop Pro へのインストール方法 ................................................................................................. 5 

Photo Impact へのインストール方法 .................................................................................................. 7 

Irfanview へのインストール方法 ........................................................................................................ 9 

製品紹介 ........................................................................................................................ 11 

Topaz Detail ............................................................................................................................................ 11 
Topaz Detail について ....................................................................................................................... 11 

Detail の動作 ........................................................................................................................................... 13 

Detail の新機能 ....................................................................................................................................... 15 

Topaz Detail 2.0 機能 ....................................................................................................................... 15 

作業領域 ........................................................................................................................ 17 

インターフェース(メインビュー) ........................................................................................................... 17 

インターフェース(ツールパネルビュー) ................................................................................................ 18 

インターフェース(パネルビューなし) .................................................................................................... 19 

インターフェース(プリセットパネルビュー) ......................................................................................... 20 

プレビューセクション ............................................................................................................................ 21 

プリセット .............................................................................................................................................. 23 

プリセットの適用方法........................................................................................................................ 23 

プリセットの追加方法........................................................................................................................ 23 

プリセットの削除 ............................................................................................................................... 25 

プリセットのインポート .................................................................................................................... 26 

プリセットのエクスポート ................................................................................................................ 27 

プリセットの共有 ............................................................................................................................... 27 

ツール ..................................................................................................................................................... 28 

メニュー .................................................................................................................................................. 29 

シリアル番号の入力 ........................................................................................................................... 29 

What’s This? ...................................................................................................................................... 30 

ユーザガイド ...................................................................................................................................... 30 

テクニカルサポート ........................................................................................................................... 30 

製品情報 ............................................................................................................................................. 30 

ギャラリー .......................................................................................................................................... 30 

My Topaz ........................................................................................................................................... 30 
チュートリアル .................................................................................................................................. 30 

製品について ...................................................................................................................................... 30 

設定とパラメータ ......................................................................................................... 31 

事前処理 .................................................................................................................................................. 31 

事前処理とは? .................................................................................................................................... 31 

事前処理は必要? ................................................................................................................................. 31 

時間がかかりますか?.......................................................................................................................... 31 

使用する画像は事前処理が必要ですか?............................................................................................. 31 

パラメータ .............................................................................................................................................. 31 



 

ディテール .............................................................................................................................................. 32 

細部のディテール ............................................................................................................................... 32 

細部ブースター .................................................................................................................................. 32 

中間部のディテール ........................................................................................................................... 32 

中間部ブースター ............................................................................................................................... 33 

広部のディテール ............................................................................................................................... 33 

広部ブースター .................................................................................................................................. 33 

色調 ......................................................................................................................................................... 34 

シアン-レッド ..................................................................................................................................... 34 

マゼンタ-グリーン .............................................................................................................................. 34 

イエロー-ブルー ................................................................................................................................. 34 

明度 .................................................................................................................................................... 34 

コントラスト ...................................................................................................................................... 34 

シャドウ ............................................................................................................................................. 35 

ハイライト .......................................................................................................................................... 35 

カラー ..................................................................................................................................................... 35 

彩度 .................................................................................................................................................... 35 

彩度増強 ............................................................................................................................................. 35 

色相 .................................................................................................................................................... 35 

ぼかしの低減 .......................................................................................................................................... 36 

ぼかし強度 .......................................................................................................................................... 36 

ぼかし半径 .......................................................................................................................................... 36 

操作の流れ .................................................................................................................... 37 

サンプルプロジェクト 1 ......................................................................................................................... 37 

サンプルプロジェクト 2 ......................................................................................................................... 42 

よくある質問 ................................................................................................................. 47 

用語集 ........................................................................................................................... 48 

ショートカットキー ...................................................................................................... 50 

製造元 ........................................................................................................................... 51 

Topaz 製品ラインナップ .............................................................................................. 52 

画像プラグイン .................................................................................................................................. 52 

映像プラグイン .................................................................................................................................. 53 

 

 
 

http://www.club-nixus.jp にてサポートページをご覧いただけます。

http://www.club-nixus.jp/


ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

4/53 

インストール 

 

Topaz Detail はそれ自体では使用できず、Photoshop などの互換性のあるホストプログラムを必要とす

るプラグインです。 

 

インストール方法 

1. Photoshopやその他の画像編集アプリケーションを起動中の場合は、それらをすべて終了してください。 

2. インストール CD、又はダウンロードしたファイルの Topaz Detail zip ファイルを開きインストーラをダ

ブルクリックしてください。インストールウィンドウが開いたら指示に従いインストールを進めてくださ

い。 

 

 

 

 

 

 

 

 

3. TopazのプラグインファイルをPhotoshopの“plug-ins” というフォルダ内にコピーして下さい。 

4. インストールの後、シリアル番号もしくはトライアルキーを入力して下さい。 

 

シリアル番号入力 

1. Photoshop にて画像を開きます。 

2. フィルタ -> Topaz Labs -> Detail 2-> メニュー -> シリアル番号の入力へと進みます。 

3. それからシリアル番号を半角英数で入力します。 

 

ホスト別インストール 

Topaz Detailは Photoshop プラグインをサポートするほとんどのホストアプリケーションで動作します。

これらのホストアプリケーションには、主に Paint Shop Pro、 Painter、 Irfanview などがあります。 

 

Topaz Detail のインストール方法はホストプログラムによって異なります。 

Paint Shop Pro や Photo Impact、 Irfanview に Topaz Detail をインストールするには、まず既定の場所に
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Topaz Detail をダウンロードして下さい。そして、各ホストが指示する方法にしたがってインストールを

進めてください。以降よりこれらのインストール方法を示します。 

 

Paintshop Pro へのインストール方法 

 

1. まず PaintShop Pro を起動して下さい。 

2. “File Types” リストの中で“Plug-ins” を選択し Menu file -> Preferences -> File Locations から“Add”

をクリックして下さい。 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

3. C:¥Program Files¥Topaz Labs¥Topaz Detail 2 plug-ins を選択し、“OK”をクリックして下さい。 
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4. Topaz Detail が使用できます。Effects -> Plugins へ進み “Topaz Detail 2”.を選択して下さい。 
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Photo Impact へのインストール方法 

 

1. まず Photo Impact を起動して下さい。 

2. File -> Preferences -> General へ進むか、またはショートカットキーF6 を使用して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. カテゴリーから Plug-ins を選択して下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

8/53 

画像・・ボタンをクリックし C:¥Program Files¥Topaz Labs¥Topaz Detail 2 へ進み”OK”をクリックし

て下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Photo Impact を再スタートして下さい。Topaz Detail が使用できます。Menu -> Effect へ進み plug-ins 

を選択します。 
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Irfanview へのインストール方法  

 

１． Irfanview ウェブページ (http://www.irfanview.com：英語)にて入手可能な Plugins/Addons をインスト

ール済みであることを確認してください。 

 

 

 

 

 

 

 

 

 

 

２．Irfanview を開き、 Image -> Effects -> Adobe 8BF filters に進んで下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.irfanview.com/
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３．ポップアップスクリーンで “Add 8BF filters”を選択し the C:¥Program Files¥Topaz Labs¥Topaz 

Detail 2¥Plugins フォルダを選択して“OK”をクリックして下さい。 Available/Loadable 8BF Filters 

セクションに“Topaz Detail 2”が表示されるようになります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

４．Topaz Detail2 を使用する時には、Image -> Effects> Adobe 8BF filters と進み、“Topaz Detail 2”を選

択してください。 
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製品紹介 

 

Topaz Detail 

 

Topaz Detail について 

Topaz Detail は細部、色調、コントラスト、カラーエフェクトを効果的に表現する画期的な画像処理技

術を用いた Photoshop プラグインです。  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Topaz Detail 適用前 
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Topaz Detail 適用後 

 

Topaz Detail は最新のアルゴリズムを用いて設定の微調整や調整用レイヤーの作成に時間をかけず効率

的な画像補正を提供します。さらに、いくつかのサンプルレイヤーを適用した補正画像が確認できるプリ

セット機能が用意されているため、それらを基準として微調整をすることで効率的な画像補正が可能とな

ります。 

 

Topaz Detail では画像の大きさに関係なく細部、トーン、コントラストなどを効果的に表現する、他に

類を見ない画像処理によって明瞭な写真を表現することができます。 

 

Topaz Detail の主な機能を以下に示します。 

1. ダイナミックに大きな画像の細部の奥行きを出すだけではなく全体的に画像を向上させます。 

2. 細部の改善を行うための識別やぼかしの低減を行います。 

3. カラー処理によって他にないカラーエフェクトを使用できます。 

4. 個々の RGB、影、ハイライト、明るさとコントラストのバランスといった先進のトーン調整機能を行

います。 

5. 細部や鋭い表現をより柔らかにするためにぼかしの低減を行います。 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

13/53 

Detail の動作 

内部処理過程の全工程を示します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. 画像を開きます。Topaz Detail を開いて下さい。 

2. 事前処理がスタートします。ご希望の画像を 2 つに分けます。1 つはクロミナンス(カラー情報)、も

う 1 つはルミナンス(グレースケール情報)が基本となっています。これらは異なる方法で処理され、

異なるスライダーで行われます。 

3. ルミナンス情報は更にサイズや画像レイヤーが基本となった 3 つの細部レイヤーに分類されます。こ

れらの 4 つのレイヤーを操作することでソフトウェアの機能を最大限に向上させます。ここの段階で

事前処理が終わり Topaz Detail ユーザインターフェースが表示されます。 

4. ユーザは様々な大きさのサイズを調整することができ各々の細部のレイヤーは適切に反映されます。

また、4つのレイヤーがどのようになっているかを見ることができます。基本レイヤーを見るために、

大・中・小のスライダーを 0 にします。各々の細部のレイヤーサイズを見るためには 1 つの画像を右

側にドラッグしコントラストを 0 に設定します。(基本レイヤーが中間グレーにスイッチします。) 

5. ルミナンスレイヤーは基本レイヤー同様、様々なサイズの細部レイヤーと合成されます。 

6. ユーザで設定するハイライト、シャドープロテクションはルマレイヤー(画像の輝度:モノクロの領域)

に適用されます。 

7. 内部ルマレイヤーとクロマレイヤーは最終的に再合成され最良の画像を作ります。 
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   Topaz Detail 適用前 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Topaz Detail 適用後 
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Detail の新機能 

Topaz Detail 2.0 機能 

 

1. 新しいユーザインターフェース 

2. 新パラメータ 最適な画像品質を更に高度にコントロールするためにぼかし強度やぼかし半径をス

ライダーで調整できるパラメータです。 

3. Undo / Redo ボタン 

4. 折りたたみサイドタブ プリセットパネルを拡大・縮小でき調整可能なワークスペース用のツールパ

ネルです。 

5. 折りたたみタブ 必要な時に開いたり閉じたりできるパラメータタブです。 

6. プリセットレイアウト 1 つのプリセットプレビューウィンドウの新プリセットフォーマットです。 

7. プリセットナビゲーション 上/下/矢印キーでプリセットリストに進むことができ、選択したプリセ

ットサムネイルを表示することができます。 (プリセットプレビューウィンドウで ) リターン 

(Enter) キーで選択したプリセットが表示されます。 

8. クイックスライダーリセット スライダー名でダブルクリックするとデフォルトの値をリセットで

きます。 

9. スピード改善 大きな画像を処理するスピードを速めます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Topaz Detail 適用前 

 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

16/53 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Topaz Detail 適用後 
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作業領域 

 

インターフェース(メインビュー) 

Topaz Detail の操作ウィンドウを見ると一見難しそうに見えますが、そのようなことはありません。多

様な機能を理解しやすいように下図のように 4 つのセクションに分けて説明します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                      

                                         

          

          

           

 

 

 

 

2.プレビュー 

編集中のプレビュー

画像を表示します 

 

1.プリセット 

あらかじめ設定されたパラ

メータを適用できます。 

4.設定とパラメータ 

さまざまな効果を調整するための 

つまみを調節します。 

 

3.プレビューナビゲーター 

現在見ているプレビュー 

画像の範囲を表示します。 

 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

18/53 

                                                                    

インターフェース(ツールパネルビュー) 

小さな白い矢印を使用するとプリセットパネルを拡大･縮小できます。白い矢印   をクリックする

か、あるいはパネルの端をつかみマウスを移動することができます。 
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インターフェース(パネルビューなし) 

小さな白い矢印を使用するとプリセットとツールパネルを拡大・縮小できます。白い矢印      

をクリックするか、あるいはパネルの端をつかみマウスを移動することができます。 
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インターフェース(プリセットパネルビュー) 

小さな白い矢印を使用するとプリセットとツールパネルを拡大・縮小できます。白い矢印   をクリ

ックするか、あるいはパネルの端をつかみマウスを移動することができます。 
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プレビューセクション 

プレビューセクションは Detail インターフェースで真ん中に位置する主要な要素です。プレビューセク

ションは元の画像と処理された画像を表示します。 

 

元のタブとプレビュータブとを切替えるとフィルタを使用した画像と使用しない画像とを比較すること

ができます。 

 

プレビュー画像を移動する時には、画面上でマウスを左クリックしその画像をつかみます。マウスから指

を離すと新たな位置に画像が移動され表示されます。 
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プレビュー画像の下の“+”、あるいは“-”ボタンをクリックしプレビュー画像を拡大・縮小でき、ウィン

ドウの大きさも調節できます。“Fit”ボタンは全体画像を画面にフィットさせます。100%未満における画

像サイズ変更では、プレビュー更新速度を速めるために内部的にサイズ変更が行われます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Photoshop と同じく、“Ctrl =” と “Ctrl –”により画像の拡大・縮小が可能です。矢印キーにより現在選

択されているスライダーの調節が可能です。ショートカットキーの全リストはこのマニュアルの後半に

記載されています。Photoshop およびその他ホストソフトウェアはグレースケール、 RGB、LAB、CMYK

などを含む多くの画像モードをサポートします。画像はチャンネルごとに、8, 16, あるいは 32 ビット

の画像を処理することができます。Topaz Detail はチャンネルごとに 8、16 ビットの両方をサポートしま

す。Topaz Detail は RGB モードのみサポートします。モノクロ写真においては最初に RGB モードに変換

します。 
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プリセット 

プリセットは Topaz Detail の全プロセスを簡略化、高速化するためのすばらしい機能です。 プリセッ

トは既存の設定で行なわれたプレビュー画像です。 

 

Topaz Detail にはいくつかのプリセットがデフォルトで用意されています。これらは個々の写真に最適

というわけではありませんが、本フィルタを使用して画像処理を施す際に基準となるフィルタとして利用

することができます。 

 

プリセットの適用方法 

プリセットの適用方法は、ただ好みのプリセットをクリックするだけです。プリセットをクリックする

と、すべてのパラメータが自動的に設定されます。その後自分なりにパラメータを微調整してください。 

 

最終プリセット画面を見たい場合、パラメータを微調整してください。 

 

プリセットの追加方法 

Topaz Detail には複数の多様なパラメータがあるため、後で使用するための設定を保存するプリセット

機能は非常に便利な機能です。設定を保存するためには、Presets メニューから“Save…”ボタンをクリッ

クしてください。 
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プリセットリストに 

あるパラメータ設定で 

”snapshots”がご使用できます。  

        

  

  

  

 

 

 

                     プリセットに保存し 

全てのリストがご使用できます。 

 

 

 

 

 

 

                     プリセットオプションで保存、削除、 

インポート、エクスポートを 

他のユーザと共有できます。 

 

 

 

 

 

プリセット名と任意の記述を入力し OK をクリックして下さい。入力した名前がすでに存在する場合、

既存のプリセットを上書きしますのでご注意下さい。 

 

保存したプリセットは”プリセット名.tpp”で新規ファイルとして保存されます。 

新規プリセットは Topaz Detail のプリセットメニューに追加され、プレビューが自動的に生成されます。

後でそのプリセットを使用したければ、メニューから生成されたプリセットを他と同様にクリックしてく

ださい。 
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プリセットの削除 

プリセットを削除したければ、“Delete…”をクリックしてください。 

すでに提供されているデフォルトプリセットを上書・削除することはできません。 

 

 

 

 

 

保存したプリセットは Topaz Detail をインストールした  C:¥Program Files¥Topaz Labs¥Topaz 

Details¥Presets 内の“Presets”フォルダ内にあります。それ以外のフォルダにインストールした場合は上記

フォルダ以外に保存されます。Presets フォルダ内にはすでにいくつかのプリセットファイルが存在して

います。 

 

Macをご使用されている方は HD/Library/ApplicationSupport/TopazLabs/Detail3/Presets内にいくつ

かのプリセットファイルが存在しています。 
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プリセットのインポート 

プリセットファイルをインポートするには、Import (インポート)ボタンをクリックして下さい。 

 

 

 

 

ブラウズボックスが表示され、保存されている Topaz Detail プリセットが表示されます。これは使用し

たいプリセットファイルをダウンロードするときに便利です。 
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プリセットのエクスポート 

 

プリセットファイルを特定の場所にエクスポートするには、“Export”をクリックしてください。その後、

このファイルをインポートした他のユーザと共有できるようになります。 

 

 

 

 

 

 保存されているプリセットに名前を入力するとデスクトップや特定の場所に保存することができます。 

 

 

 

 

 

 

 

 

 

 

その後、このファイルをインポートした他のユーザと共有できるようになります。 

 

プリセットの共有 

 

また、現在の設定を e メールに添付することができます。 
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ツール 

 

画像補正をするためにツールパネルで様々なツールを使用できます。 

 

1. プレビューナビゲーター 

現在、ご覧になっている画像範囲をプレビューナビゲーターで 

見ることができます。 

 

2. ズームボタン 

 画像の拡大が可能です。あるいは画像をプレビュー画面にフィット 

させたり、あるいは 100%の大きさで見ることができます。 

 

3. 取り消し(アンドゥー) / やり直し(リドゥー)ボタン 

 

4. スライダーとパラメータ 

 様々なエフェクトを適用するためにスライダーを使用して 

編集することができます。 

 

5. スライダーコントロールの追加 

“全てリセット(Reset All)”ボタンを押すと全てのスライダー値を 

0 に戻すことができます。 
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メニュー 

フィルタウインドウの右下にある Menu ボタンより Topaz Detail のメニューにアクセスできます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

シリアル番号の入力 

ライセンスキーを入力します。 
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What’s This? 

Detail インターフェースについて説明いたします。 

 

ユーザガイド 

このユーザーズガイドを開きます。 

 

テクニカルサポート 

技術的なサポートページへご案内いたします。 

 

製品情報 

 Topaz Detail ウェブページにご案内いたします。 

 

ギャラリー 

 インターネットブラウザを開き Topaz Detail 画像ギャラリーをクリックすると他のユーザの画像を見

ることができます。 

 

My Topaz 

  

チュートリアル 

 

製品について 

 現在使用している Detail のバージョンを見ることができます。 
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設定とパラメータ 

 

事前処理 

 

 

 

 

 

事前処理とは? 

  画像のディテールを細部、中間部、広部の 

3 つのレイヤーに自動的に分けるプロセスです。 

 

事前処理は必要? 

 ハロー効果を導入しないやり方で画像を引き出すために必要な 

方法ですのでご使用ください。 

 

時間がかかりますか? 

 はい、大きな画像を使用するときに数秒かかることがあります。 

 

使用する画像は事前処理が必要ですか? 

 はい、全ての画像は画質を上げる前に事前処理をしてください。 

  

パラメータ 

Topaz Detail には最適な画像を得るために 4 つの設定タブと合計 18 個のパラメータが存在します。 
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ディテール 

Detail は画像内で 3 つのレベルのディテールを調整できる画期的な画像処理技術を用いています。画像

の細部、中間部、広部のディテールを補正できます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上記のスライダー名でダブルクリックをすると簡単にディテール値を”0”に戻すことができます。 

 

細部のディテール 

これは細かい部分のディテールを補正するパラメータです。 

このパラメータで補正することで明瞭な画像を表現いたします。 

 

細部ブースター 

この細部のディテールスライダーで画像の細かい部分を極度に増減します。このブースターを使用する

と画像の細部の印象を薄くしたり強調させたりします。 

 

中間部のディテール 

これは中間部のディテールを補正するパラメータです。このパラメータで補正することで中間部分のデ

ィテールを明瞭に表現いたします。 
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中間部ブースター 

この中間部のディテールスライダーで画像の中間部分を極度に増減します。このブースターを使用する

と画像の中間部の印象を薄くしたり強調させたりします。 

 

広部のディテール 

これは広部のディテールを補正するパラメータです。このパラメータで補正することで広部のディテー

ルを明瞭に表現いたします。 

 

広部ブースター 

この広部のディテールスライダーで画像の広部を極度に増減します。このブースターを使用すると画像

の広部の印象を薄くしたり強調させたりします。 

 

”細部ディテール”と”細部ブースター”を使用しますと肌の質感を補正したり、あるいは画像ノイズを減ら

すことが可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

34/53 

色調 

 色調タブは画像の明度、コントラストの強弱、あるいは色合いのぼかしや、色合いの低減を行います。

これにより、驚くような色彩効果を生み出すことができるのです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

シアン-レッド 

 赤の色に関連する色合いの明度に影響を与えます。 

 

マゼンタ-グリーン 

  緑色に関連する色合いの明度に影響を与えます。 

 

イエロー-ブルー 

 青色に関係する色合いの明度に影響を与えます。 

 

明度 

 画像の明度を増減させます。 

 

コントラスト 

 画像のコントラストを増減させます。 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

35/53 

 

シャドウ 

 シャドウからの低減を行う機能が内蔵されています。(最も暗い色調) 

このパラメータを上げることでシャドウのざらつきや不明瞭さを低減します。 

 

ハイライト 

 ハイライトからの低減を行う機能が内蔵されています。(最も明るい色調) 

このパラメータを上げることでハイライトのざらつきや不明瞭さを低減します。 

 

カラー 

カラータブでは適応的な色彩調整を適用しています。画像上のカラーで作用します。このタブにて魅力

的な色彩効果を演出してください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

彩度 

画像全体の彩度を増減する標準パラメータです。 

 

彩度増強 

画像の弱い色を増減させます。 

 

色相 

色相を補正制御することができます。 
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ぼかしの低減 

このタブ(ぼかしの低減)ではお使いの画像の不明瞭さを削減することができますので画質をなめらかに、

はっきりとシャープにすることができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

ぼかし強度 

 これはぼかしの削減強度を増減できる標準パラメータです。 

 

ぼかし半径 

大きな半径ではぼかしの低減を大きなサイズで行います。また、パラメータの値が小さいと小さなぼかし

の低減が行われます。 

 

ぼかしの追加方法 

1. すべての画像にぼかしを低減するタブを使用することはありません。 

2. 理想的な使用方法は小さなぼかしの発生に使用することです。 

3. ピクセル数を変更すると最も効果的です。 

4. 適用し過ぎますと画像に斑点がでます。 

5. 細部のディテールと細部のブースターを共に使用すると良いでしょう。 

6. プレビューには 50%以上に拡大表示する必要があり、それ以下ですと、ぼかしの低減機能は使用でき

ません。 
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操作の流れ 

 

サンプルプロジェクト 1 

本セクションでは Detail をより熟知していただくために実際の操作例を示します。 

 

                                    

 

 

 

 

 

 

 

 

                            

Detail 適用前                    Detail 適用後 

                     

上記のサンプル写真をご覧下さい。 

Detail を使用する前と後とでは、細部が鮮明に修正されているのがお分かりかと思います。 

以降より、最適な画像を得るための操作方法を示します。 

 

1. 画像ファイルを開きます。 

 

2. 画像の複製レイヤーを作成します。 

レイヤー上で右クリックして”レイヤーを複製”を選択して 

ください。またはレイヤーを”新規レイヤー”アイコンまで 

ドラッグしてください。 
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3. 画像処理を行なうにはフィルタ ->Topaz Labs -> Detail 2 へと進んでください。 

 

4. Topaz Detail をスタートすると事前処理されディテール調整準備に入ります。数秒かかります。 

 

 

 

 

 

 

 

5. 画像が調整されましたらズームインツールを使用したい部分をズームインします。それからプレビュ

ー画面をクリックしご希望の箇所までドラッグします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

39/53 

                                       

6. 左側のプリセットパネルより自分のイメージする 

                                         画像に近いものがあればスクロールします。各パラメータ 

  のつまみが自動的に動き、選択したプリセットの設定に合 

わせられます。実例として Creative Detail Accent プリセッ

トを使用します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

このプリセットの設定でよろしければ 

”OK”ボタンを押し Photoshop に保存できます。 

 

さらに補正をしたい場合、4 つのタブにある 

スライダーを手動で動かしてご希望の画像に 

補正することができます。 
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7. まず、始めにディテールタブから説明していきます。 

ここからスタートし色調、ぼかし、カラーと進んで 

いきますと画像の補正効果を簡単に確認することができます。 

 

8. 細部、中間部、広部のディテールのスライダーを 

ゆっくりと補正していきます。それから細部、中間部、広部の 

ブースターのスライダーを使用すると各部の強度の補正が 

可能となります。 

 

 

 

 

 

 

 

9. 色調タブで画像の個々の色合いを最適にコントロール 

することができます。ここで実際にフォトポップを作成する 

ことができます。 

 

10. 色調のスライダーを徐々に増減させることでカラーの 

明度の度合いを調整することができます。その後、残りの 

スライダーを使用して明度のクォリティ、深さ、色相、暗度、 

などを補正いたします。 

 

 

 

 

 

 

 

 

次にぼかしの低減タブについて説明します。全ての画像はこのタブで補正する必要がありますが、只、

お使いの画像が補正する必要のない場合はスキップしてカラータブへとお進みください。 
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11. ぼかしの低減タブを使用して画像の不明瞭さを削減することができます。 

 

 

 

 

 

 

 

 

 

12. ぼかし強度のスライダーを徐々に増減させることでぼかしの低減量を増減することができます。ぼ 

し半径のスライダーで補正するとどのようにぼかしの低減が適用されたかが決められます。 

最後にカラータブで画像の彩度と色相の補正を行います。このスライダーで補正すると全ての補正は完了

です。 

 

 

 

 

 

 

 

 

 

 

最後に OK を押すと補正された画像を見ることができます。 

 

 

                                                            

 

 

これでドラマティックに、そして 

カラフルに補正された画像の誕生 

です。 
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サンプルプロジェクト 2 

本プロジェクトでは Detail を熟知していただくための２番目として、モノクロ変換に焦点をあてて実

際の操作例を示します。 

 

 

 

 

 

 

 

 

                              

 

  

Detail 適用前                                           Detail 適用後 

 

上記のサンプル写真をご覧下さい。 

Detail を使用する前と後とでは、色の脱飽和が修正されているのがお分かりかと思います。以降より、最

適な画像を得るための操作方法を示します。 

 

1. 画像ファイルを開きます。 

 

2. 画像の複製レイヤーを作成します。レイヤー上で 

右クリックして”レイヤーを複製”を選択してください。 

またはレイヤーを”新規レイヤー”アイコンまで 

ドラッグしてください。 
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3. 画像処理を行なうにはフィルタ ->Topaz Labs -> Detail 2 へと進んでください。 

 

 

 

 

 

 

 

4. Topaz Detail をスタートすると事前処理されディテール調整準備に入ります。数秒かかります。 

 

5. 画像が調整されましたらズームインツールを使用したい部分をズームインします。それからプレビュ

ー画面をクリックしご希望の箇所までドラッグします。 
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                                        6. 左側のプリセットパネルより自分のイメージする画像 

                                          に近いものがあればスクロールします。各パラメータ 

                                          のつまみが自動的に動き、選択したプリセットの設定 

                                          に合わせられます。実例として BW Contrasted プリセット

を使用します。 

                                            

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

このプリセットの設定でよろしければ”OK”ボタンを 

押し Photoshop に保存できます。 

 

さらに補正をしたい場合、4 つのタブにあるスライ 

ダーを手動で動かしてご希望の画像に補正するこ 

とができます。 

 

 

 

 

 

 

 

 



ご不明な点がありましたら http://www.nixus.jp よりお問い合わせください。 

45/53 

7. まず、始めにディテールタブから説明していきます。 

ここからスタートし色調、ぼかし、カラーと進んで 

いきますと画像の補正効果を簡単に確認することができます。 

 

8. 細部、中間部、広部のディテールのスライダーを 

ゆっくりと補正していきます。それから細部、中間部、広部の 

ブースターのスライダーを使用すると各部の強度の補正が 

可能となります。 

 

 

 

 

 

 

 

9. 色調タブで画像の個々の色合いを最適にコントロール      

することができます。ここではコントラストのスライダーが 

最も大切な設定となります。 

 

10. 色調のスライダーを徐々に増減させることでカラーの 

明度の度合いを調整することができます。その後、 

残りのスライダーを使用して明度のクォリティ、深さ、色相、暗度 

などを補正いたします。 

 

 

 

 

 

 

 

次にぼかしの低減タブについて説明します。全ての画像はこのタブで補正する必要がありますが、只、

お使いの画像が補正する必要のない場合はスキップしてカラータブへとお進みください。 
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11. ぼかしの低減タブを使用して画像の不明瞭さを削減することができます。 

 

 

 

 

 

 

 

 

 

12. ぼかし強度のスライダーを徐々に増減させることでぼかしの低減量を増減することができます。ぼか

し半径のスライダーで補正するとどのようにぼかしの低減が適用されたかが決められます。 

 

最後にカラータブで画像の彩度と色相の補正を行います。このスライダーで補正すると全ての補正は

完了です。 

 

 

 

 

 

 

 

 

 

最後に OK を押すと補正された画像を見ることができます。 

 

 

 

 

 

 

                             これでドラマティックに、そして 

カラフルに補正された画像の誕生 

です。 
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よくある質問 

 

 

“Photoshop のフィルタメニューに Topaz Detail が見当たりません。” 

Windows ご使用の方： 

１． C:¥Program Files¥Topaz Labs¥Topaz Detail 3¥Plugins内の tlDetail3.8bfファイルをコピーしてくださ

い。 

２． 通常 C:¥Program Files¥Adobe¥Adobe Photoshop CSx¥Plug-Ins に位置する Photoshop の Plug-Ins

フォルダ内の Topaz Detail に関連する全ファイルを削除してください。Topaz Detail や tlDetail3.8bf

というファイル名が付けられているはずです。その後先ほどコピーした tlDetail3.8bf を貼り付けてく

ださい。 

３． Photoshop を終了し、再起動してください。Topaz Detail がフィルタメニュー内に表示されるはずで

す。Topaz Detail を使用するには事前に画像を開いている必要があります。 

 

Mac ご使用の方： 

１． /Library/Application Support/Topaz Labs/ Detail 3/Pluginsフォルダ内のTopaz_Detail3.pluginファイル

をコピーしてください。 

２． Applications/Adobe Photoshop CSx/Plug-Ins (もしくは Photoshop Plug-Ins フォルダがある場所)。 

Topaz Detail に関連するファイルすべてを削除してください。その後、右クリックより先ほどコピー

した Topaz_Detail3.plugin ファイルを Photoshop Plug-Ins フォルダ内に貼り付けてください。 

３． Photoshop を再起動し、Topaz Detail がフィルタメニュー内にあることを確認してください。Topaz 

Detail を使用するには画像を開かなければなりません。 

 

“プリセットが見れません。” 

おそらくお使いのプリセットファイルが読み込み不可となっているからです。Mac においては、

“/Library/Application Support/Topaz Labs/ Detail 3”をチェックし、Presets フォルダにて右クリックして

ください。すべてのユーザに対して尐なくとも読み込み可能となっているかどうかを確認してください。

プリセットを保存したい場合は、書き込み可能にする必要があります。 

また、規定のフォルダにインストールされていない場合は、プリセットは表示も保存もできません。 

 

 “どこにシリアル番号を入力すればよいですか？” 

 シリアル番号入力のため、まず Photoshop にて画像を開きます。フィルタ -> Topaz Labs -> DeJPEG3 

-> メニュー... ->シリアル番号の入力..と進み入力画面が表示されます。 
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用語集 

 

アルゴリズム－問題を解くための効率的手順を定式化した形で表現したもの。 

チェッカーボーディング－チェッカーボードのような大きな画素ブロックの形をした歪み。通常は圧縮率

の高い画像に生じ、特に情報量の多い領域に見られる傾向があります。 

カラーチャネル－主要な色の組み合わせで多彩な色を表現するデジタルカラー画像のカラー要素。典型的

なデジタル画像では Red（赤）、Blue（青）、Green（緑）をカラーチャネルとする RGB カラーモデルが

使用されます。 

カラーノイズ－不鮮明なエッジに見られるデジタルノイズ、または画像の色ムラや不自然な点の集合。 

圧縮アーティファクト－不可逆圧縮による画像や映像に見られる歪み。 

ダウンロード－あるデバイスから他の端末へのデータ転送プロセス。 

エッジアーティファクト－画像内のエッジに見られるアーティファクトや歪み。 

エクスポート－転送しようとしているデータを他のプログラムが使用可能な形式に変換すること。 

画像圧縮－画像データの圧縮。不可逆圧縮、特にデータ量の尐ないものは圧縮によりデータが失われ、よ

り多くのアーティファクトを発生させます。最も広く使用されている画像圧縮形式は JPEG です。 

インポート－入手しようとしているデータをファイルやドキュメント形式に変換すること。 

可逆圧縮－本質を保ちつつデータサイズを削減する再生可能な圧縮方法です。 

不可逆圧縮－データを近似することでサイズを削減する再生不能な圧縮方法です。 

ノイズ－デジタルカメラにより撮影された画像に生じる干渉をいい、画像にランダムな色合いにちりばめ

られた点や、均一な色が続く領域に見られるムラとして確認されます。たいていは暗い部分や影になって

いる部分に発生します。ノイズは全体的な画質を損なう望ましくない効果であるか、もしくは芸術的な効

果として使用される場合もあります。 

パン－カーソルをプレビューの上でクリックしてそのままドラッグすることでプレビュー画面を自由に

移動させる機能。 

パラメータ－目的となる結果に変化を与えるいくつかの変数のうちの一つ。 

プラグイン－システムの向上のために追加できるモジュールやソフトウェア。 

プリセット－製品にあらかじめ備えられているパラメータと設定。Topaz 製品にはデフォルトプリセット

が備えられています。また、プリセットが示す効果を一目で確認できるサムネイル画像が備わっています。 

プレビュー－編集中の画像表示。プレビューセクションは右上の大きな画面となります。 

スムージング－表面を滑らかにすること。目に見える突起、こぶ、へこみを平らにします。 

 

CMYK－プリンターによる印刷において使用されるシアン、マジェンダ、イエロー、ブラックの 4 色を使

用したカラーモデルをいいます。 

Grain－画像を自然に見せるために使用する軽い斑点の集合のようなノイズ。 
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ISO－デジタルカメラにおけるセンサの感度を示します。ISO が高いほどシャッタースピードは速くなり、

暗いところでの撮影に向いていますが、ノイズが増加しやすくなります。 

Luma－画像の輝度（色のないモノクロの領域）。Luma は色のない画像を示し、Chroma は色情報を示し

ます。 

RAW 画像－圧縮やノイズ除去などされていない未加工の画像。 

RGB－Red（赤）、Green（緑）、Blue（青）を基本としてすべての色を表現するカラーモデル。デジタル

カメラやコンピュータのモニタに使用されているモデルです。 
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ショートカットキー 

 

作業効率アップのため Topaz Detail ではいくつかのショートカットキー が使用できます。以下のキーは

全工程にて使用可能です。 

動作 Mac Windows 

オリジナル画像の確認 SPACEBAR SPACEBAR 

すべてリセット CMD -ALT-R CTRL-ALT-R 

画像サイズを画面にフィット CMD -0 CTRL-0 

画像の 100%表示 CMD -ALT-0 CTRL-ALT-0 

拡大 + or CMD -+ + or CTRL-+ 

縮小 - or CMD - - - or CTRL- - 

アンドゥー CMD -Z CTRL-Z 

リドゥー CMD –Shift-Z CTRL-Shift-Z 

 

以下のショートカットキーも使用できます。 

D ディテールタブの 6 つのパラメータの表示/非表示 

T 色調タブの 7 つのパラメータの表示/非表示 

B ぼかしの低減タブの 2つのパラメータの表示/非表示 

C 色相/彩度/明度の表示/非表示 

↑, ↓ プリセット上でスクロール 

Return (enter) key プリセットを適用 

[ key 0.1 ごとに減尐 

] key 0.1 ごとに増加 

Home  最小に設定 

End  最大に設定 

スライダー名をダブルクリック 0 にリセット 
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製造元 

 

NIXUS（北海道日興通信株式会社）所在地 

〒060-0041  

札幌市中央区大通東７丁目１２番地３３水野ビル 

TEL：011-251-4251（代表）、011-251-4381（システム部） 

FAX：011-251-4564 

http://www.nixus.jp 

Topaz Labs LLC 所在地 

5001 Spring Valley Road  

Suite 400 East  

Dallas, TX 75244  

Phone: 972.383.1588  

Fax: 866. 876.1393  

 

技術サポート 

NIXUS： 

http://www.club-nixus.jp 

support@hnikko.co.jp 

 

Topaz Labs LLC はダラス、テキサスの私企業で、高度な映像および画像補正技術の開発に取り組んでい

ます。今日広く使用されているデジタルスチルカメラや、デジタルビデオカメラ、HDTV などとともに、

高画質なデジタル画像および映像のニーズは非常に高まっています。Topaz Labs の使命は実験的な最先

端の画像・映像補正技術をプロや一般の顧客に提供することです。 

http://www.nixus.jp/
http://www.club-nixus.jp/
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Topaz 製品ラインナップ 

 

画像プラグイン 

 

 

  

  

  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

画像における露光、詳細、色彩

の総合的コントロールが写真

をポップに仕上げます。 

高度なノイズ軽減手法により

画像の細部を保持しつつ楽に

ノイズを取り除くことができ

ます。 

どんな写真でも美しい絵画の

ように仕上げることができま

す。 

はっきりとした画像を創りま

す。また、凹凸を平らにする効

果もあります。 
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映像プラグイン 

  

 

 

画像の鮮明度の向上、再構成、

引き伸ばし、高品質ノイズ除

去、JPEG 圧縮補正における総

合的な画像補正ができます。 

高度な JPEG 圧縮アーティフ

ァクト除去フィルタにより画

像の詳細を保ちつつ JPEG 圧

縮アーティファクトを除去す

ることができます。 

容易に、効果的にビデオフレー

ムを捕らえ、画質と解像度を向

上させます。 

超解像技術を活用しながら最

適な映像補正フィルタにより

映像を向上させます。 


